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RESUMO

A modelagem tridimensional muito ja contribuiu com a industria do entretenimento e
agora tem sido amplamente utilizada na manufatura e criagdo de novos produtos. A
possibilidade de se ter um modelo de um produto a um preco menor € com uma
maior rapidez tem feito essa técnica ser cada vez mais aceita em todas as areas da
engenharia. Quando ja se tem um modelo real e deseja-se realizar alguma
modificagdo, simulagdo ou mesmo replicar o produto, a engenharia reversa muito
pode contribuir, pois permite a obtengdo do modelo tridimensional a partir do objeto
real. Os equipamentos de digitalizacdo tridimensional tém um alto custo de
investimento, mesmo os de baixa precisdo. A comunidade de entusiastas de
software e hardware livre busca também distribuir e popularizar o conhecimento
compartilhando suas descobertas e contribuindo abertamente com outras iniciativas.
Buscamos nesse projeto construir um scanner 3D utilizando software e hardware
livre utilizando componentes de baixo custo e facil aquisicdo, estabelecendo seus
limites técnicos, estimulando assim a adogao de técnicas de engenharia reversa. O
processo de calibragem, captura e pos tratamento da nuvem de pontos obtidas foi
detalhado na construcdo de modelos para comparagdo de dimensdes e
levantamento de caracteristicas da superficie do material.

Palavras-chave: Modelagem tridimensional. Engenharia reversa. Aquisigao

tridimensional.



ABSTRACT

The three-dimensional modeling has contributed much to the entertainment industry
and has now been widely used in manufacturing and creating new products. The
possibility of having a model of a product at a lower price and a higher speed have
made this technique is increasingly accepted in all fields of engineering. When there
is already a real model and you want to make any changes, simulation or even
replicate the product, reverse engineering can greatly contribute, as it allows to
obtain three-dimensional model from the real object. The three-dimensional scanning
equipment have a high investment cost, even low accuracy. The community of
enthusiasts of open source and open hardware also distribute and popularize
knowledge sharing his findings and openly contribute to other initiatives. We seek in
this study, build a scanner 3D using free software and hardware components using
low-cost and easy acquisition, establishing its technical limits, stimulating the
adoption of reverse engineering techniques. The calibration, capture and post-
treatment process of the cloud of points obtained was detailed in the construction of
models for comparison of dimensions and survey of surface characteristics of the

material.

Keywords: Three-dimensional modeling. Reverse engineering. Three-dimensional

acquisition.



LISTA DE FIGURAS

FIGURA 1 — Taxonomia das Técnicas de Reconstrugdo Tridimensional ................ 17
FIGURA 2 — Aquisi¢cao de Dados no Processo de Reconstrugdo 3D ...................... 17
FIGURA 3 — Grid Digital CUDICO.......ccccuiiiiiee it 18
FIGURA 4 — Pixel (2D) versus VOXel (BD) .....ccccuriiiieeeeeiiieeee et 18
FIGURA 5 — Método de aquisigéo fatiamento de pinos para Implantes Dentarios. .. 19
FIGURA 6 — Brago Articulado Digitalizador Microscribe® ................cccooiiiiiiiiiiennnee. 20
FIGURA 7 — Maquina de Medi¢ao de Coordenadas com cabeca de leitura da
RANISNAW ® ... et ettt e e e e e e e e e e e e e e e e eeeennnnne 21
FIGURA 8 — Equipamento de Ressonancia Magnética em Corte .............ccccceeeee 22
FIGURA 9 — Tomografia Computadorizada (Gantry, PC e Esquema Interior do

(L= 11174 O TP TPRPPPP 23
FIGURA 10 — Fatias de Imagens e Modelo Tridimensional Construido com TC....... 24
FIGURA 11 — Ultrassonografia €m 3D-4D ... 25
FIGURA 12 - Reconstrugao Volumétrica 3D de Tuneis com Imagens Obtidas por
P R . e e e e e e e — e e e e e e e e e e e e e e ———aaaeeeaaanraaaaan 26
FIGURA 13 —Principio do Time Of FlIght ..............oooo oo 27
FIGURA 14 — Calculo da distancia entre objeto e sensor.............cocooiiiiiiiiiiiinnnee. 28
FIGURA 15 — Dispositivo Microsoft Kinect Sensor ®...............cccoceeeiiiiiiicie e, 28
FIGURA 16 — Geometria do Processo de Triangulagdo .............coooeeiiiiiiiiiniiinnneee. 29
FIGURA 17 — Projecao de Luz Estruturada ..o, 31
FIGURA 18 — Exemplos de Padrdes de Luz Estruturada ...........c.....oooooiiinnnn. 32
FIGURA 19 — Interferometria (Franjas de MOIr€) ...........cccooeeiiiiiiiiiiiiiiiiiiee 33
FIGURA 20 — Formacgao das franjas de moiré pela sobreposigéo de reticulos de
HNNAS PAralElas ........cooiieee e e e e e e e e e e e e e e e eeeenannees 34
FIGURA 21— Projecao das Franjas de Moiré sobre um Objeto ..............cceevveeennnnnns 35
FIGURA 22— Visdo Estéreo e Estimativa de Profundidade ..., 37
FIGURA 23 — Geometria ESIEre0..........uuuuuiiiiiiieee e 38

FIGURA 24 — Envoltéria Visual Inferida com um processo de interse¢cdo de volumes
conicos definidos pelas Silnuetas ... 40
FIGURA 25 — Aquisi¢cao de Formas por Movimentagao/Rotacéo — Proposta de
Sistema AULOMAtIZAAO .......cooiiii e 41



FIGURA 26 — Esquema para aquisicdo de Forma por Sombreamento..................... 42

FIGURA 27 — Modelo adquirido com a técnica de sombreamento.......................... 43
FIGURA 28 — Scanner FabScCan ..ot 44
FIGURA 29 — Scanner CebSCan...........uuuuuiiiiiiieee e 46
FIGURA 30 — Scanner Atlas 3D ..o e e e e eeeeeeenees 47
FIGURA 31 — Scanner BQ CiClOP ....ooeeiiiiiiiiiiie e 48
FIGURA 32 — Placas ZUM Core (esquerda) e ZUM SCAN (direita) ...........ccvvvvvenee. 49
FIGURA 33 — Arduino Uno, Driver A4988 e Shield CNC V3.......ccccooiiiiiiiiiiiiieieins 52
FIGURA 34 — Modulo laser com feixe em linha ..., 52
FIGURA 35 — Motor NemMat7 ... e e e e e eeeeeenees 53
FIGURA 36 — Camera LogiteCh C270 ... 53
FIGURA 37 — Alimentagao Shield CNC ... 54
FIGURA 38 — Esquema de Montagem Eletrénica do Scanner ...............cccccvvvvveeneen. 55
FIGURA 39 — Teste de Componentes Eletrdnicos............ccoceeeveviiiiiiieiiiiiiiiee e, 58
FIGURA 40 — Impressao 3D da Estrutura do Scanner ..............ccoceeeeiiiiiiiieieceeeennne, 59
FIGURA 41 — Sugestado de Montagem da Estrutura do Scanner...............ccccoooe.. 59
FIGURA 42 — Fases do processo de Calibragem do Horus ..............cccoiiiiiiiiiinnee. 61
FIGURA 43 — Ambiente de Captura do Software Horus ............cccccoeeiiiiiiiinnnennnnn. 62
FIGURA 44 — Ajuste manual do foco da camera .............ooouuieiiiiiiiiiieie e 63
FIGURA 45 — Ambiente MeshLab ..............eiiii e, 64
FIGURA 46 — MeshLab — Calculo de Normais do Modelo...........cccoooeeeiiiiiiiiiiiiinnnee. 65
FIGURA 47 — MeshLab — Exibigdo de NOrmais ............ooooiiiiiiiiiiiiiieee e 66
FIGURA 48 — Construgao do Scanner Finalizada...............ccccoooiiiiiiiiiiiie e, 68
FIGURA 49 — Objetos utilizados nos testes de digitalizag8o ..............cceeeeeevreeeiennnnns 69
FIGURA 50 — Digitalizag&o de Esfera Metalica.............cccccoiiiiiiiiiiiiiiiiie 70
FIGURA 51 — Comparacao de Medidas do Modelo e da Peca Real ........................ 70
FIGURA 52 — Comparativo entre esfera metalica real e modelo obtido ................... 71
FIGURA 53 — Modelo melhorado com filtro de suavizag&o ..........cccceeeeeeeeeiieeeeeinnnes 72
FIGURA 54 — Medi¢des de superficie na malha de pontos .........c.cccoeeeiviiiiiiiineeennnn. 72

FIGURA 55 — Objetos com superficie reflexiva e com partes em vermelho............. 73



LISTA DE SIGLAS

A — Ampere

2D - Bidimensional

3D — Tridimensional

CC - Creative Commons (Criagdo Comum)

CCD - Charge Coupled Device (Dispositivo de Carga Acoplada)
CNC - Controle Numérico Computadorizado

FDM — Fuséao e Deposicao de Material

GPL - General Public License (Licenga Publica Geral)

GPR - Ground Penetrating Radar (Radar de Penetragdo no Solo)
MDF — Medium Density Fiberboard (Fibras de Média Densidade)
MMC - Maquina de Medi¢ao de Coordenadas

PLA — Acido Polilactico

PLY — Polygon Format File (Formato de Arquivo Poligonal)

RM - Ressonéncia Magnética

SLR - Digital Single Lens Reflex

STL — Formato de Arquivo 3D originario da palavra STereoLithography
TC - Tomografia Computadorizada

US - Ultrassonografia

VREF - Valor de Referéncia



2.1
2.2

3.1
3.2
3.2.1
3.3
3.3.1
3.3.2
3.4
3.4.1
3.4.2
3.4.3
3.5
3.5.1
3.6
3.6.1
3.6.2
3.7
3.71
3.7.2
3.7.3
3.7.4
3.8
3.8.1
3.8.2
3.8.3
3.8.4
3.8.5

41
4.2

SUMARIO

13V 30 01U 031 Yo 13
OBUETIVOS ...t s s e e e e 15
OBUJETIVO GERAL. ... eieiecmeeeeme e s sssssssssssss s ssssss s s ssse s sassmns s ssssmne s ssssmnssnsans 15
Objetivos ESPeCifiCOS .......ceummmimiiiiiiiiiiiiinssnennrr s 15
REVISAO DA LITERATURA ...ttt esas e sas e sne e ese e sae e s e e e nens 16
RECONSTRUGCAOQO TRIDIMENSIONAL.....cccceueeeaeeraereraesessesesesesesessessssesssaes 16
METODOS COM CONTATO FiSICO DESTRUTIVO ..couveeeeeeeeerereeresnenenns 18
Fatiamento........miiiic e ——————— 18
METODOS COM CONTATO FiSICO NAO-DESTRUTIVO ...ccceeerereerernenene 20
Brago Articulado...........eeeeeiiiiiiiii i 20
Maquina de Medicao de Coordenadas (MMC) .............cccoviiiiiiiiiiinnnnnnnnns 21
METODOS TRANSMISSIVOS .....ooieeeerrecerereeressssesessssesessssssesssssssssssssssenes 22
Ressonéncia Magnética............ccceriiiiiiiinmsmmmeirr e 22
Tomografia Computadorizada...........cccceeriiiiiiiiiiiiiiin 23
Ultrassonografia .......ccccceeeiiiiiiiiiiiiiiissesssrr s 24
METODOS REFLEXIVOS NAO-OTICOS ....coveeeereererereeressesesesssesessssssenes 25
Radar de Penetragao no Solo (GPR).......cccccmmmmimiiiiiiisscssneeees 25
METODOS REFLEXIVOS OTICOS ATIVOS....cceeeeeerereeeeeneeseesseessssssens 27
Tempo de V6o (Time of Flight)........ccueeveeiiiiiiiiiiiiieeenrnnnn e 27
TrianQUIAGA0 .....coviiiiccee e ———————— 29
METODOS REFLEXIVOS OTICOS PASSIVOS.....c.cceeereererneeeessseessssesenes 36
EStereoSCoPia ...cooiiiiieeeeeiirii s 36
SilRUEtas.......cooiiic e —————— 39
1V LA VAT 4 0= 41 - T U 20 41
Sombreamento.........cccciiiiii————— 42
SCANNERS TRIDIMENSIONAIS OPEN SOURCE ......ccoocimrriinieennesiinnne 43
Projeto FabScan ... 44
Projeto CebScan.........cooiiiiiiiiiiiiniciser i —————— 45
Projeto Atlas 3D ... ——————— 46
[ o 1= L T 0T [ o 47
Comparativo entre Scanners Open Source. ..........ccooriimmmmnnnnneesssss, 49
MATERIAL E METODOS.........ceceiiuecieneeeeeseseesessesessssssessssssesssssssssssssnssans 51
COMPONENTES ELETRONICOS.....cucceeerreireeeresesasesessssesessssssesessssssessssens 51

MONTAGEM DOS COMPONENTES ELETRONICOS......cccoeeerererererararaeenens 53



SOFTWARE DE CONTROLE DO HARDWARE .....cciiiiiieererrnsssnee e 56

ESTRUTURA DO SCANNER 3D ...t rnnssssss s snssssss s ssssssss e 58
AQUISICAO DE MODELOS....cccetruruerererseseresssesessssssesssssssssssssssssssssssssssssssssns 60
POS PROCESSAMENTO DA NUVEM DE PONTOS ....ccceecrererererarasaesenens 63
RESULTADOS E DISCUSSOES .......cccoseeiererecrersesesssesessssesesssssssessssssnens 68
(o0 ] N o I U= 0 ] 1= 0P 74
SUGESTOES PARA TRABALHOS FUTUROS ........ccccovurerererereresseeressnaenes 75

REFERENCIAS ........ccoeririrererereeeescreresesasas s e esesesesssasasasssssssesesssasasssssnsssenes 76



13

1 INTRODUGAO

A modelagem tridimensional (3D) € um campo que tem sido muito solicitado
atualmente, tanto no entretenimento, com jogos e filmes, quanto na industria,
substituindo metodologias ja consolidadas por um custo menor de produ¢do e uma
reutilizacdo constante. Produzir um modelo tridimensional atualmente é algo bem
mais simples, pois ha uma infinidade de softwares que auxiliam nessa tarefa.

De acordo com Azevedo e Tavares (2009), o processo de reconstrugéo
tridimensional tem se tornado relevante nas ultimas décadas especialmente na area
médica e industria cinematografica, no entanto temos acompanhado um vasto
crescimento de sua aplicagdo nos campos de engenharia, geologia, astronomia,
biologia, etc. Isso tem se tornado mais intenso porque o volume de imagens tem
aumentando exponencialmente; equipamentos como tomografos, sonares,
telescopios, cameras digitais, além de uma infinidade de sensores tem se tornado
cada vez mais acessiveis e presentes no nosso dia-a-dia.

Uma aplicagdo para essa tecnologia tridimensional nos ultimos anos foi a
‘engenharia reversa”, técnica da qual se parte do objeto final para se obter um
modelo 3D, permitindo assim sua modificacdo e produgéo.

O processo de engenharia reversa envolve uma leitura do objeto real
produzindo sua nuvem de pontos nos eixos “X,y,z” (largura, altura e profundidade) e,
através de software especifico, geragcado de sua malha geométrica para reconstrugéo
tridimensional.

Muitas abordagens foram apresentadas nos ultimos anos para a tarefa de
aquisicao e reconstrucdo 3D; muitos fabricantes apresentam ao mercado suas
propostas de produtos, no entanto a um custo que chega a ser proibitivo,
dependendo da técnica utilizada e precisdo do equipamento.

A busca por um scanner de custo acessivel se justifica por permitir a
popularizagdo da tecnologia. Definir seu potencial de aplicagdo na resolugdo de
problemas da engenharia como a extragdo de informagdo sobre a superficie do
objeto, pode nortear uma nova abordagem na analise de superficies frageis. A
abordagem por triangulacao a laser € objeto desse estudo, pois permite uma grande
precisao na superficie do objeto capturado, mesmo tendo dimensdes reduzidas.
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A comunidade de entusiastas por software livre baseando-se em estudos
cientificos e as vezes por simples prazer da pratica “faca vocé mesmo” tem
apresentado interessantes ideias de aplicagdo das técnicas de captura a
equipamentos de custo minimo. Por serem essas publicacbes sempre feitas de
modo muito informal, essas informagdes sdo encontradas em foruns de discussao
na internet ou mesmo em paginas pessoais conhecidos como blogs; raros exemplos
apresentam uma documentacdo técnica que detalhe a construcdo sem elevados

conhecimentos das técnicas, eletrébnica e desenvolvimento de softwares.
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2 OBJETIVOS

2.1 OBJETIVO GERAL

Contribuir para o desenvolvimento da tecnologia nacional de prototipagem
rapida demonstrando que é possivel se obter modelos tridimensionais de boa
qualidade de maneira rapida utilizando um scanner tridimensional de facil fabricagao

e simples operacao.

2.2 Objetivos Especificos

= Analisar os projetos livres propostos para digitalizagdo tridimensional e
obter parametros de construgédo scanner 3D

» Realizar a construgdo de um scanner 3D utilizando cédmera e sensores
laser de baixo custo e ampla disponibilidade no mercado nacional.

= Automatizar o processo de captura da peca utilizando base giratéria com
micro-controlador e motor de passo.

» Realizar a configuragado e adaptacdo de softwares de cédigo livre para
aquisicao de imagens e geragao de malha de superficie do objeto.

» Realizar o escaneamento de objetos de diversas dimensdes a fim de
fornecer os parametros de qualidade do scanner obtido.

= Exportar arquivos capturados em formatos compativeis com softwares de
manipulacéo e impressao 3D.

= Analisar o potencial dos modelos capturados para levantamento de

informagdes sobre a superficie do objeto.
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3 REVISAO DA LITERATURA

3.1 RECONSTRUGAO TRIDIMENSIONAL

Segundo Carvalho et al (2005), as varias técnicas s&o primeiramente
categorizadas em emprego do contato fisico com o objeto ou sem envolver contato
fisico. As técnicas de captura baseadas em imagens do objeto, por exemplo, sdo
subdivididas em ativas e passivas. Todas as técnicas empregam um conjunto de
hardware e software especificos, que buscam o calculo da profundidade dos pontos
na cena de forma semelhante ao olho humano para definir detalhes de formas e
volume do objeto.

Um modelo € uma representagao do objeto real ou imaginario e podem ser
empregados mapas de profundidade (Z(x, y)), malhas de poligonos (polygon
meshes), equagdes de curva e superficie, além de vetores, gradientes e
inclinagao/rotagéo para sua criagdo. (FOLEY et al., 1997).

Atualmente, existem varios equipamentos e técnicas que buscam a
obtencao de superficies (perfilometria); alguns baseados em contato fisico, algumas
vezes destrutivo e sem contato fisico; nesse campo, destacam-se os métodos oticos.
A figura 1 mostra a taxonomia das técnicas de reconstrugcdo tridimensional com

adaptacdes de técnicas desenvolvidas e aperfeicoadas nos ultimos anos.



FIGURA 1 — Taxonomia das Técnicas de Reconstrucido Tridimensional

Com
Contato Fisic
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Fonte: Adaptado de Azevedo (2012)

Quanto a estruturacado dos dados na aquisi¢cao, podemos classificar as

técnicas de acordo com a figura 2.

FIGURA 2 — Aquisicdo de Dados no Processo de Reconstrugédo 3D

Volumétrico

Nuvem de Pontos

Fonte: Adaptado de Sisgraph (1999)

Stereo (Estereoscopia)
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Os sensores de captura de imagens tridimensionais operam, de modo geral,
projetando (na forma ativa) ou adquirindo (na forma passiva) energia
eletromagnética em/de um objeto, em seguida, registrando essa energia

transmitida ou refletida. O exemplo mais

importante de medida de

transmissdo de energia é a tomografia computadorizada industrial (CT no
acrdnimo em inglés), que utiliza raios X de alta energia e mede a radiacao
transmitida pelo objeto.” (SANSONI et al., 2009, p.570).
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De acordo com Braga Neto (1994), escolher um esquema de representagao
tridimensional na reconstrucdo ou o grid digital € essencial, pois consiste
exatamente em como serdo distribuidos os elementos digitais que compdem a
imagem, determinando a topologia digital, seus conceitos de vizinhangca e

conectividade.

FIGURA 3 — Grid Digital Cubico

Fonte: Braga Neto (1994)

A figura 3 apresenta um grid digital cubico, uma das possiveis escolhas de
representacédo, também conhecido como modelo “voxel’, que segundo Braga Neto
(1994) é um acronimo para volume elemento, unidade basica de uma imagem
tridimensional, assim como o pixel o é para a imagem bidimensional. A figura 4

apresenta um comparativo entre o pixel e o voxel.

FIGURA 4 — Pixel (2D) versus Voxel (3D)

Pixel Voxel

Fonte: Préprio autor.

3.2 METODOS COM CONTATO FiSICO DESTRUTIVO

3.2.1 Fatiamento

O Fatiamento é um método destrutivo em engenharia reversa é util para a
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objetos pequenos e complexos pois nela os recursos internos e externos séo
examinadas. De acordo com Raja e Fernandes (2008), uma fresadora CNC
(Controle Numérico Computadorizado) realiza cortes transversais na pecga (fatia), e
as imagens sdo capturadas por uma caémara de alta qualidade. O software de
digitalizagdo automaticamente converte a imagem digital, detectado pontos e entéo

€ renderizado o modelo tridimensional da fatia.

O processo de aquisicdo de dados de um sistema destrutivo € apresentado
na figura 5. A desvantagem deste método é a destruicdo do objeto. Contudo, a
técnica € rapida e precisa: £ 0.0127mm. A espessura de cada camada € de 0.0127-
0.254mm. O método também permite capturar a estrutura interna do objeto. (RAJA
E FERNANDES, 2008).

FIGURA 5 — Método de aquisigao fatiamento de pinos para Implantes Dentarios.

~

S \'&h\\b_
—

Fonte: Hudak, Zivéak e Magin (2016)

Outra das vantagens desse método € quanto ao material aplicavel, que
podem ser pecas feitas em aluminio, plasticos, ferro fundido, aco, cobre e até

mesmo a madeira.
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3.3 METODOS COM CONTATO FiSICO NAO-DESTRUTIVO
3.3.1 Bracgo Articulado

O digitalizador de braco articulado é um dispositivo montado sobre uma base
relativamente pesada e possui articulacbes que permitem sua movimentacdo em
todas as diregdes. Em toda a extensdo do brago existem sensores que permitem
saber a posicdo da ponta do brago no espaco e assim obter informacdes que serdo

utilizadas na reconstrucao tridimensional.

Segundo Azevedo (2012), as coordenadas medidas sdo enviadas a um
computador, que constroi a malha geométrica do objeto 3D, conforme mostra a
figura 6. A posigao real da ponta do brago externo € calculada por goniometria1, que
mede os angulos entre os bragos digitalizador nas articulagdes.

A precisao desse bracgo articulado € um de suas grandes vantagens pois &
por volta de 0.04mm conforme publicacdes técnicas de seus fabricantes. Um dos
problemas encontrados € quanto a geometria do objeto a ser capturado, pois
algumas areas podem né&o ser acessiveis pelo sensor do brago. Uma variagdo dessa

técnica emprega um emissor laser na ponta do brago articulado.

FIGURA 6 — Braco Articulado Digitalizador Microscribe®

Fonte: Microscribe (2016)

' Goniometria - Mensurar objetivamente as amplitudes de movimento articular através do gonidémetro.
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3.3.2 Maquina de Medicao de Coordenadas (MMC)

As maquinas de medicao de coordenadas (do inglés, Coordinates Measuring
Machines) sao equipamentos de medicdo de alta precisdo, que podem ser

automaticas ou manuais, disponiveis em pequeno, médio e grande porte.

Basicamente, os equipamentos possuem uma base fixa onde o objeto é
colocado e um brago extensivel com uma sonda articulada (intercambiavel) que
desliza sobre a superficie do objeto. Segundo Renishaw(s.d.), capturando medidas
com margem de erro de apenas um digito em microns e velocidade de até 500mm/s;
quando a ponta da sonda toca a pecga e deflete, o refletor € deslocado. A trajetéria
de retorno alterada do laser € medida por um sensor de posi¢céo. A posigcao exata da
extremidade da ponta € conhecida porque o refletor e a esfera da ponta estdo muito

proximos, conforme ilustra a figura 7.

FIGURA 7 — Maquina de Medicao de Coordenadas com cabeca de leitura da

Ranishaw ®

Fonte: Renishaw (2016)

Devido a sua alta precisdo, a industria automobilistica e aeronautica sao
seus maiores consumidores, utilizando-a para medi¢gdes de engrenagens, guias de
valvulas, bielas, hélices e blocos de motor. Esses valores de medi¢cao sao enviados
a um computador que, através de software proprio pode reconstruir o modelo
tridimensional através da nuvem de pontos. Sua principal desvantagem é o alto

custo desses equipamentos, que chegam a custar mais de meio milhdo de ddlares.
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3.4 METODOS TRANSMISSIVOS
3.4.1 Ressonéancia Magnética

Segundo Funari (2013), Ressonancia Magnética (RM) como & conhecida
atualmente comecgou a tomar forma com pesquisas realizadas na década de 1920,
comprovada na década de 1940, mas so foi experimentada na década de 1960,
quando surgiu o primeiro espectrometro de RM para fins analiticos. Desde entéo, a
espectrometria € usada para analisar a configuragdo molecular do material baseado
em seus espetros de RM. No inicio da década de 1980, quase todos os fabricantes
de equipamentos de imagens médicas pesquisaram e produziram scanners de RM

que produziam imagens.

A RM utiliza campos magnéticos e ondas de radio para criar imagens
transversais de alta qualidade sem utilizagdo de radiagao ionizante, segundo Rajas e

Fernandes (2008), o que torna o processo mais saudavel.

Quando prétons de um determinado objeto, sdo colocados em um campo
magnético forte, enviando pulsos de radiofrequéncia eletromagnéticos, estes protons
emitem sinais que sao recolhidos e processados para construcdo das imagens

transversais, conforme ilustra a figura 8.

FIGURA 8 — Equipamento de Ressonancia Magnética em Corte

Paciente
Bobina de
\\ y Radio
, Freqiiéncia
Mesa do
Paciente
Bobina de
Gradiente
Magneto

(ima)
Scanner

Fonte: Singapore (2016)

As imagens transversais do objeto alvo s&o “empilhadas” de modo a formar
o cubo tridimensional e se obter assim o modelo 3D.
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3.4.2 Tomografia Computadorizada

Segundo Rajas e Fernandes (2008) a tomografia computadorizada (TC) é
uma abordagem poderosa para a reconstrugdo 3D, ela revolucionou o campo do
diagnéstico médico desde os anos 1970. E um método transmissivo, ndo destrutivo,
que permite a visualizagdo ftridimensional das partes internas de um objeto
fornecendo uma grande série de imagens obtidas por meio de raios-X em corte

transversal tomada ao redor de um eixo de rotagao unico.

Em TC, o feixe de raios-X que ultrapassa o material através de inumeras
projecdes realizadas em torno do objeto e a porgdo emergente é captada pelo
sistema de detectores e armazenada na memoria do computador. (MASCHIO, 1997)

Segundo Garib (2007) durante o exame de TC, no interior do Gantry, o tubo

de raios-x gira dentro do anel estacionario de receptores, conforme a figura 9.

FIGURA 9 — Tomografia Computadorizada (Gantry, PC e Esquema Interior do

AN
N

&5 I‘I‘Hcgf

Gantry)

. |
Ty,

evannsssy

f“

Fonte: Adaptado de Garib (2007)

Ainda de acordo com Garib (2007), os aparelhos modernos de TC
apresentam uma tecnologia denominada multislice e séo capazes de obter de 4 a 16
fatias de imagem a cada giro de 360°, obtendo fatias de 0,5 a 20mm de

profundidade (voxel), o que diminui o tempo de exposigao do paciente aos raios-X.

A figura 10 apresenta uma série de imagens capturadas por uma TC de um

cranio humano; a direita, o modelo construido a partir dessas imagens.
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FIGURA 10 — Fatias de Imagens e Modelo Tridimensional Construido com TC

Fonte: Adaptado de Newworldencyclopedia (2016)

3.4.3 Ultrassonografia

De acordo com Kealy et Al (2012), o termo ultrassonografia (US) designa
ondas sonoras de alta frequéncia, inaudiveis ao ouvido humano. O ouvido humano
consegue captar frequéncias da ordem de 50 a 20.000 hertz (1KHz = 1.000 ciclos
por segundo). Na ultrassonografia diagnostica as frequéncias normalmente
utilizadas séo entre 2 e 15 megahertz (1MHz = 1 milhdo de ciclos por segundo).
Essa onda sonora ultrassdnica atravessa o objeto em analise até encontrar um
obstaculo que reflita parte dessas ondas (eco) ao emissor/receptor denominado
transdutor; um computador analisa os sinais emitidos e recebidos e converte em

uma imagem bidimensional, em escalas de cinza em um monitor em tempo real.

Os primeiros instrumentos de US que produziam imagens tridimensionais
(3D) surgiram em 1991, armazenavam 25 segundos de imagens e levavam horas
para construir o modelo. Atualmente, a US 3D captura as imagens e reconstroi o
modelo em alguns segundos, além de ter agregado o recurso de produzir um video
tridimensional, conhecido como 4D. (BONILLA-MUSOLES; MACHADO, 2005).
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FIGURA 11 — Ultrassonografia em 3D-4D

Fonto Adaptado de Arruda (2012)

A figura 11 apresenta uma imagem tridimensional de um bebé de 37
semanas de gestagédo. O equipamento de US 3D-4D é praticamente 0 mesmo que o
US bidimensional, basicamente, apenas um novo software de analise de sinais, no
entanto esse software possui um alto custo (atualmente, em torno de 15.000 Euros),
0 que o torna impeditivo a muitos pacientes e pesquisadores.

A US e ressonancia magnética tem em comum o fato de ndo serem
invasivas, submetendo o paciente a radiagdo ionizante como a tomografia, no

entanto a US ainda tem uma grande vantagem: produzir imagens em tempo real.

3.5 METODOS REFLEXIVOS NAO-OTICOS

Os métodos de reconstrugao tridimensional ndo éticos ndo possuem contato
fisico e utilizam sensores e emissores de ondas eletromagnéticas ou ainda raios X
para obtengdo das formas de objetos. Esta técnica é utilizada na ressonancia

magnética, tomografias, sonares e radares.

3.5.1 Radar de Penetragao no Solo (GPR)

O Radar de Penetragdo no Solo ou Georradar € mais conhecido pelo
acronimo de GPR (Ground Penetrating Radar), segundo Riviero e Sola (2016) foi
proposto e apresentado por Sir Robert Alexander Wattson-Watt em 1935. O radar

terrestre ficou popular na década de 1970 e é hoje um equipamento conhecido dos
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geologos, pois tem sido amplamente utilizado para estudos do subsolo. E utilizado
para analises de placas tectbnicas, definicdo de espessuras de camadas de gelo,
investigacdo de sitios arqueologicos e até mesmo pelas forgas policiais para

verificagcao de existéncia de tumulos clandestinos.

A técnica de reconstrugao tridimensional volumétrica é feita utilizando as
imagens produzidas pelo GPR. Na figura 12, conforme Riviero e Sola (2016), o
processo € descrito em fases: primeiramente, as imagens s&o submetidas a um filtro
de imagens (entre 68MHz e 822MHz) para remocgéao do plano de fundo (background)
e logo apdés as imagens s&o empilhadas, formando um cubo. As camadas de
imagens que forma o cubo tridimensional sdo interpoladas com um padrao de cores

de 8 Bits, gerando o modelo do que esta no subsolo.

FIGURA 12 - Reconstrugao Volumétrica 3D de Tuneis com Imagens Obtidas por
GPR.

Fonte: Riveiro e Sola (2016)
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3.6 METODOS REFLEXIVOS OTICOS ATIVOS

Os meétodos de reconstrugdo tridimensional oticos ativos n&o possuem
contato fisico e utilizam cameras de alta capacidade e emissores de luz (incluindo
laser) para obtencdo das formas de objetos analisando as imagens capturadas e

submetendo-as a um algoritmo especifico.

3.6.1 Tempo de Véo (Time of Flight)

A técnica denominada Time of Flight (Tempo de Véo). E caracterizada pela
utilizacdo de um emissor e um detector de luz; basicamente € medido o tempo que a

luz leva para se propagar do emissor até o objeto e para sua volta.

Segundo INPE-DSR (2007), a técnica se baseia na medigdo do tempo entre
a emissao e retorno do pulso refletido como mostra a figura 13.

FIGURA 13 —Principio do Time of Flight

t1

t0
.
2 =

Fonte: Inpe-Dsr (2007)
t0 — O pulso é disparado na diregdo do objeto;
t1 — Ao atingir a superficie do objeto, parte do pulso é refletida na diregdo do sensor;

t2 — No sensor, sdao medidos o tempo decorrido entre a emissao e a captacédo do

retorno e também a intensidade do retorno;

Para medir a distancia entre o sensor e o objeto a partir do tempo calculado entre

emissao e retorno.
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FIGURA 14 — Calculo da distancia entre objeto e sensor

__________________________

Fonte: Inpe-Dsr (2007)
Como visto na figura 14, podemos definir a distancia ao considerarmos que:
Velocidade = Distancia / Tempo
Ou ainda:

2*R dt (1)

R=cx—

Segundo INPE-DSR (2007) existem duas alternativas para se medir o
tempo: o sistema de pulsos e o sistema de onda continua. O retardo do pulso
refletido e captado permite determinar a distédncia (R). No sistema de ondas
continuas, o intervalo entre a emissdo e registro do retorno é determinado
calculando a diferenca de fase entre a onda de retorno em relagdo a onda emitida.

A figura 15 apresenta o popular dispositivo Microsoft Kinect Sensor®,
utilizado em jogos de videogame e interagdes com aplicagdes para computador,
esse dispositivo € um o6timo exemplo da utilizacdo da técnica de Time of Flight,
utilizando um projetor projetor e camera infravermelho e uma camera RGB (Red
Gren Blue) para captar os movimentos do operador e gerar modelos tridimensionais

em tempo real.

FIGURA 15 — Dispositivo Microsoft Kinect Sensor ®

(1) IR projector f2\.‘ RGB camera (3) IR camera
e >/

Nas”

a) b) c)
Fonte: Azevedo (2012, p. 22)
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A técnica do tempo de vb6o tem recomendacgao de utilizagdo para captacao
de imagens de objetos de alguns centimetros até cerca de cem metros, dependendo
do sensor empregado.

3.6.2 Triangulagao

Segundo Gazziro (2011) o processo de aquisi¢ao 3D por triangulacdo é feito
através da projecdo de um feixe de linha vertical produzida por um emissor laser
sobre a superficie do objeto a ser capturado; essa projecao é entdo capturada pela

camera e a distancia até o objeto se da através de calculo geométrico.
A figura 16 demonstra como ocorre o0 processo de aquisigao triangulagéo.

FIGURA 16 — Geometria do Processo de Triangulagao

A f

Plano da™ / —_linha projetada
! \\' pelo laser

imagem /1/1e —) O/ \
da camera Y
\

Ponto 3D (x. v, 2) \__~

Fonte: Gazziro (2011)

Ainda segundo Gazziro (2011) o centro das lentes esta localizado na origem
com distancia focal f até o plano da imagem sendo a distancia entre o projetor e a
camera representado pela linha de base b. A projecéo do laser forma o dngulo 6 em

relacdo a linha base e o ponto 3D (x, y, z) no espago real é projetado no pixel da
imagem ( x’, y’).

O valor de 6 é conhecido pelo sistema e a distancia focal f € determinada
pela calibragdo da cadmera. A linha de base b é calculada posicionando-se o laser de

maneira que a sua projegao incida no centro do objeto a ser adquirido, apontando
para um objeto a uma distancia conhecida z.
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_ Zo (2)
tanf

Um ponto (x,y,z) é entdo projetado na camera no espaco (x’, y’) de forma
que:

. xf i (3)

Inicialmente é feita uma varredura girando-se o laser que estara projetando
uma linha vertical, capturando as imagens, armazenando os respectivos valores de 6
obtidos pelo sinal de varredura de cada imagem. Determina-se os valores de x’ e y’
onde o laser foi refletido para cada imagem e entdo, os pontos nas coordenadas
reais sdo calculados pelas equagdes abaixo:

_bx by’ Z:L, (4)
x—m Y T fcot@—x

Ainda de acordo com Gazziro (2011), a principal vantagem de se utilizar
técnicas de luz estruturada como essa € o baixo custo. No entanto eles tendem a
nao ser muito precisos porque a resolucéo do sistema é limitada a resolucéo do pixel

de medida x’e y'.

3.6.3 Luz Estruturada

Segundo Carvalho et al (2005) os primeiros métodos de codificagédo por luz
estruturada foram propostos na década de 80 e aprimorados na década de 90. Para
capturar toda a superficie do objeto e ndo apenas uma linha temos que projetar o
laser de varias formas de modo a varrer toda a superficie. Projetar varias linhas ao
mesmo tempo utilizando um sistema de correspondéncia é a base do conceito de

“luz estruturada”.
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Um padréo de luz contendo é projetado na cena, os planos onde podemos
recuperar a geometria com maior precisdo € na transi¢gdo de faixas. A figura 17

apresenta um modelo de montagem de equipamentos para utilizagdo do processo.

FIGURA 2 — Projecao de Luz Estruturada

—

Sistema
sensor

Sistema
projetor

Sistema
computacional

Fonte: Reiss (2007)

Conforme afirma Reiss (2007), com o projetor posicionado a certa distancia do
sensor fixo e sua orientagdo em relagédo ao projetor conhecida é possivel determinar
a coordenada do ponto por meio de um processo de intersec¢cdo, semelhante aos
sistemas de Triangulagdo a Laser ou Estereoscopia. As relagdes geométricas entre
0 projetor e o sensor precisam ser conhecidas, entdo, € necessario um processo de

calibragao.

Podem ser utilizados diferentes padrbes de luz, como linhas, grades,
senoidais, circulos. Assim, o projetor simula a segunda camera no processo e torna
a reconstrugao tridimensional mais rapida do que o sistema estereoscopico. A figura

18 apresenta exemplos de projecao de padrdes de luz estruturada.
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FIGURA 18 — Exemplos de Padrbes de Luz Estruturada

l | .
- e
Objeto

Objeto

Imagem Plana Ponto Unico Imagem Plana L5 e L
Objeto ! . I *
Objeto
Imagem Plana Padrao em linhas drs J J
codificadas Imagem Plana Padrao em Grade

Fonte: Raja e Fernandes (2008)

De acordo com Paiva (1997), a calibragdo da cémera permite obter a
equacao da linha de visdo que une um ponto da cena ao centro 6tico da lente da
camera. A calibragao projetor permite obter a equagao do plano de luz/sombra com
0 codigo yp que incide em um ponto da cena. Depois de calibrado o sistema, a
determinacdo das coordenadas x, y, z (3D) de determinado ponto da cena é dado
pela interseccdo da linha de visdo com o plano de luz projetado. Uma das formas de
se chegar a esse valor é utilizando o modelo pinhole, dado pelas equacgdes:

(Ci1 — C31.0).x+ (Cip — C52.0).y + (Cy3 — C33.0).2=1—Cyy (5
(C21 = C31.))-x + (Coz = C32.)).y + (Co3 — C33.)). 2= — Cpy
Em que os parémetros Cj; sdo determinados na calibragédo da camera e ij

s&o coordenadas correspondentes a esse ponto na memoria de imagem. A equagao
do plano com o codigo y, € dada por:

(P11_ P21-}’p)-x+ (P12_ Pzz-Yp)-Y+ (P13_ P23'yp)'Z:yp_ Py (6)
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Utilizando-se as equacgdes 5 e 6, obtemos o seguinte sistema de equagdes lineares:

(C1 — C31.1) (Cha — Cg0.1) (Cz3 — Cy3.1) €T 1 —Cyy (7)
(Cop — C31.7)(Cag — C32.5)(Co3 — Ca3.7) | - |yl = |7 —Cxn
) Z Yp Plrl

(P11 — Poryp) (Pra — Coa.yp) (Prz — Cas.yp

Que determinam os valores (x,y,z) equivalentes ao ponto tridimensional.
3.6.4 Interferometria (Técnicas de Moiré)

A técnica de interferometria j@ € bem conhecida no controle dimensional,
assim como em medi¢cdes de nivelamento e deformagdo, em que padrdes de luz
estruturada séo projetados sobre uma superficie para produzir sombra, conhecida
como efeito moiré. (RAJA; FERNANDES, 2008)

Moiré € uma palavra de origem francesa que tem como significado um tecido
de seda ondulado. Segundo Lino (2002), se refere a um tecido de seda composto
por duas camadas cujo movimento relativo entre elas gera padrées semelhantes a
ondas denominadas de franjas de moiré.

Podemos observar o fenbmeno moiré quando ha difracdo da luz que passa
por duas telas com um pequeno angulo entre elas, resultando na formagao de

padrées chamados de franjas de moiré, conforme ilustra a figura Figura 19

FIGURA 19 — Interferometria (Franjas de Moiré)

Fonte: Préprio autor.
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Para Lino (2002), quando essa superposi¢cao das camadas ocorre formando
um pequeno angulo de intersecdo entre as linhas dos reticulos, pequeno
deslocamento em um dos dois reticulos provocara grandes deslocamentos nas
franjas de moiré, isto é, o deslocamento sera magnificado. E que, considerando que
possuem linhas equidistantes, e um deles (reticulo R1), que possui linhas paralelas
ao eixo “y”, com periodo “p1”, & sobreposto pelo outro (reticulo R2), com linhas com
linhas com periodo “p2”, diferente de “p7”, formando um angulo 6 entre as linhas dos
dois reticulos. Observa-se o aparecimento de um terceiro reticulo (franjas de moiré)

formado pela intersec&o das linhas dos reticulos R1 e R2 (Figura 20).

FIGURA 20 — Formacgao das franjas de moiré pela sobreposigéo de reticulos de

linhas paralelas

Fonte: Cloud (1998)
Conforme Coud (1998), um exame da figura 20, mostra que:

p, senf (8)
\/plz + p2? — 2p;1 p, cosO

sen @ =
onde:
¢ = angulo formado entre as franjas de moiré e o eixo das ordenadas
p1 = periodo de R1

p2 = periodo de R2



35
6 = angulo formado entre as linhas R1 e R2
e ainda:

_ P1P2 (9)
\/p12 + p;? — 2p; p, cosb

Pm

Onde pm € o periodo da franja de moiré.

S&o0 necessarios dois reticulos, um deles segue o contorno do objeto e é
chamado de reticulo deformado ou reticulo do modelo (Rm) e o outro permanece
indeformado e serve como referéncia, por isso € chamado de reticulo indeformado
ou de referéncia (Rr). (LINO, 2002). Sciammarella (1982) classifica os métodos de
moiré em 3 grupos: Técnica de Moiré ou Moiré Intrinseca, Moiré de Projecgao,
também conhecido como Moiré de Sombra e Moiré de Reflexao.

Segundo Lino (2002), o reticulo do modelo € projetado obliquamente a
superficie do objeto, modulando ou acompanhando a topografia do mesmo. Para se
obter a deformacé&o fora do plano, os reticulos do modelo (Rm) e de referéncia (Rr)
sdo a projecao do mesmo reticulo, um antes e outro depois do objeto ser deformada.
As franjas sao formadas pela sobreposi¢do das duas imagens conforme demonstra
a figura 21.

FIGURA 21— Projecao das Franjas de Moiré sobre um Objeto

Fonte: Oliveira (2006)

Ainda de acordo com Oliveira (2006), as técnicas de moiré apresentam uma
dificuldade na obtencdo da forma tridimensional de todo o objeto pois a iluminagéo
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através destas técnicas gera apenas a superficie da area fotografada, e ha uma alta
probabilidade de surgimento de ruido em regides limitrofes de objetos de formas

esféricas.

3.7 METODOS REFLEXIVOS OTICOS PASSIVOS

Os meétodos do grupo de reconstrugédo o6tica passiva sdo empregados em
aquisicao de modelos superficies ou estruturas contidas em uma cena. Nesse grupo
estdo processos de aquisicdo de modelos utilizando cameras em aeronaves ou um

pequeno objeto em uma cena com a mesma técnica (estereoscopia).

Essas técnicas precisam, normalmente, de menos equipamento sofisticado,
no entanto demandam mais processamento computacional. Algoritmos para
reconstrugdo por Textura, Focagem, Movimentagdo, Silhueta, Sombreamento,
Imagens Estéreo estdo agrupadas nessa categoria. A seguir sdo detalhados alguns

desses processamentos.

3.7.1 Estereoscopia

A estereoscopia é uma técnica conhecida ha anos, pois as fotografias
comuns sdo bidimensionais e ja transmitem as informagdes relativas a largura e
altura dos objetos (x, y); para uma reconstru¢do tridimensional seria necessario
apenas mais uma informagao: a profundidade (z). Segundo Jose (2008), a chave é
encontrar as correspondéncias entre duas ou mais imagens do mesmo objeto. Nas
abordagens utilizando cameras estéreos, a estratégia esta em simular o sistema

visual humano, a chamada visao binocular ou estereoscopica.

De acordo com Scharstein (1999) a visdo estereoscopica € a inferéncia
geométrica da cena a partir de duas ou mais fotos tiradas simultaneamente de
posicdes ligeiramente diferentes. A informac&o de profundidade & obtida entdo por
meio da obteng¢do da disparidade entre pontos correspondentes nas duas imagens.
Mesmo quando se ha uma grande quantidade de imagens a serem analisadas, elas

sao sempre analisadas aos pares.
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FIGURA 22— Visao Estéreo e Estimativa de Profundidade

ot el

Fonte: Matworks (2016)

Na figura 22, é realizada a reconstrugéo da cena usando um par de imagens
estéreas (topo da figura). Para visualizar a disparidade, as imagens da direita e da
esquerda sdo combinadas em uma nova imagem. Um mapa de disparidade é entéo

montado para entdo ser renderizada a imagem tridimensional.

Seja um ponto P e suas duas imagens: P, na imagem da esquerda e Pgr na
imagem da direita. Seja f a distancia focal e b a distancia entre as duas cameras.
Considerando que o ponto P tem uma profundidade Z e um deslocamento lateral X
(em relagdo a camera da esquerda) e ainda P, esta na coordenada X, e Pr na
coordenada Xg como demonstra a figura 23.



FIGURA 23 — Geometria Estéreo
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Fonte: Jose (2008)
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Para a disparidade d, temos:
f*b (12)

Como afirma Jose (2008), a disparidade é diretamente proporcional a
distancia focal f e a distancia entre as cameras b e que € inversamente proporcional
a profundidade Z. Uma vez que a distancia focal e a distancia entre as cameras sao
constantes para um determinado par de imagens, o mapa de disparidades prové
uma relacio inversa das profundidades da cena em questao.

A principal dificuldade dessa técnica esta na definicdo de pontos correlatos
entre as imagens a serem analisadas, uma das maneiras de se encontrar essa
correspondéncia de pontos € a chamada convolugdo? entre pequenas janelas com

pontos significativos entre as imagens; no entanto, a um alto custo computacional.
3.7.2 Silhuetas

O método de reconstrugdo denominado Forma por Silhueta (Shape from
Silhouette), segundo Azevedo (2002) € baseado no conceito de envoltéria visual
(visual hull); € um método que busca a obtengdo do modelo 3D a partir de varias
fotografias, utilizando algoritmos de segmentacdo de imagem, separando o objeto
alvo do fundo (cenario) da fotografia.

Logo, a geometria do objeto € adquirida a partir de fotografias 2D
convencionais de diversos angulos e sdo empregados algoritmos para se obter o
real posicionamento da camera e a silhueta do objeto em cada uma das fotos.

A ideia de se extrair a forma de um objeto através da silhueta em imagens
de diversos angulos surgiu na década de 1960, quando Frangois Villeme
desenvolveu um método que denominou photo-sculpting (fotoescultura): 24
fotografias da superficie de um objeto sao feitas e projetadas no barro (PAVLIDIS et
al., 2007).

Como na pratica ndo é possivel utilizar um ndmero infinito de imagens na
reconstrugdo de uma estrutura, procura-se obter uma aproximagao da
Envoltéria Visual, através de um processo de intersecgao de volumes

2 Convolugao é o nome dado a uma operagdo matematica entre dois sinais, cuja saida € um terceiro
sinal.
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conicos, com base nas restricbes impostas pelas silhuetas obtidas e os
centros de projecdo associados, obtendo-se assim a Envoltéria Visual
Inferida — Inferred Visual Hull (AZEVEDO, 2002, p. 61)

A figura 24 apresenta o processo de interse¢cdo de volumes coénicos
definidos pelas silhuetas obtidas nas imagens.

FIGURA 24 — Envoltéria Visual Inferida com um processo de intersecdo de volumes
conicos definidos pelas silhuetas

R

Fonte: Sisgraph (1999)

Segundo Carvalho (2005), logo apos a determinagdo das silhuetas é
construida uma estrutura de paralelogramos no espago 3D, baseada na combinagéo
das projegdes ortograficas das silhuetas de duas imagens escolhidas de forma
arbitraria. No passo posterior, constroi-se uma representagdo por volumes
segmentados, composto por um conjunto de segmentos de reta paralelos a um dos
eixos de um sistema de coordenadas local escolhido adequadamente. A estrutura de
dados utilizada para representar os volumes segmentados é entdo organizada de
forma hierarquica para a facilitar o processo de intersecdo de segmentos. Apos
estas etapas, a representagao por volumes segmentados é entéo refinada através
de outras silhuetas provenientes de outros pontos de vista.
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3.7.3 Movimentagao

A técnica de aquisicao por “Movimentacado” ou “Rotagdo” é uma técnica que
complementa a técnica de aquisi¢ao por silhuetas. Basicamente, o objeto é colocado
em rotacgéo frente a uma camera estacionaria ou uma camera que gira em torno de
um objeto fixo, varias imagens sao capturadas e s&o submetidas a um
processamento para extragdo da silhueta do objeto e construgcdo do solido.
(SZELISKI, 1990)

Segundo Niem (1994), pode-se construir uma pirdmide tendo como
referencia o ponto de foco da camera e a silhueta extraida de cada imagem, cada
piramide pode ser considerada uma aproximagdo do modelo ou, como sao

comumente chamadas, uma envoltoria visual (visual hulls).

FIGURA 25 — Aquisicdo de Formas por Movimentagao/Rotacdo — Proposta de
Sistema Automatizado

Fonte: Laboratoire de Vision (2016)

A figura 25 apresenta uma proposta dos pesquisadores Mikhnevich e Hébert
do Laboratoire de Vision et Systemes Numériques da Universidade de Laval, na
Franca, que consiste em uma base giratoria e hastes luminosas para captura das

imagens e geracao da envoltoria visual do objeto.
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3.7.4 Sombreamento

O método de aquisicdo por sombreamento (shape from darkness ou shape
from shadow) infere 0 modelo da cena baseando-se nas informagdes das sombras
projetadas sob a iluminagdo de uma fonte de luz; pode-se deslocar a fonte de luz em
torno do objeto ou mesmo colocar o objeto sobre uma base giratoria, mantendo a
fonte de luz fixa.

Savaresse et al (2001) propéem um sistema que chamaram “Shadow
Carving” (numa tradugédo livre, Escultura de Sombra) para obter um modelo
tridimensional utilizando a forma de silhuetas e sombra. As silhuetas sdo usadas
para reconstruir a estimativa inicial das formas e as sombras do objeto sdo utilizadas
para esculpir as concavidades.

A figura 26 apresenta o sistema de inferéncia da forma baseado em sua

projecéo de sombras.

FIGURA 26 — Esquema para aquisicdo de Forma por Sombreamento

Linha da Imagem
0‘ Imagem Plana o. 9

L / Fatia da Imagem

-

- Sombra da Imagem Segmentada,

Contorno do - L

@ Objeto P ; .

Areado
Objeto Ap
-
Objeto

Fonte: Adaptado de Savarese et al (2001)

De acordo com Savarese et al (2001) a fonte de luz L ilumina um objeto e
langa uma sombra sobre algumas areas em sua superficie e ao se processar a
imagem, as sombras sao separadas. A principal informagédo vem das inconsisténcias
entre as sombras que seriam produzidas pela superficie estimada e as sombras
observados que sado verdadeiramente produzidos pela superficie real. Assim, pode-
se remover (esculpir) regides da estimativa do objeto atual a fim de reduzir as

inconsisténcias e, portanto, de forma incremental calcular melhores estimativas da
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forma do objeto. A figura 27 apresenta um resultado de experimento utilizando essa

técnica, mostrando trés fases de captura do objeto.

FIGURA 27 — Modelo adquirido com a técnica de sombreamento

Fonte: Savaresse et al. (2001)

3.8 SCANNERS TRIDIMENSIONAIS OPEN SOURCE

Um novo ideal tem ganhado cada vez mais defensores atualmente com a
popularizagdo da internet: O codigo livre. Nesse tipo de iniciativa os
desenvolvedores de hardware e software disponibilizam seus projetos a comunidade
de desenvolvedores por todo o mundo para que, de um modo colaborativo o projeto
seja mantido, aperfeigoado e popularizado.

Por tras dos projetos open source existe uma filosofia que defende a
liberdade para qualquer pessoa modificar aperfeicoar, compartilhar e em alguns
casos até mesmo comercializar.

Projetos de hardware livre também estdo indo na mesma diregdo,
componentes eletrbnicos, circuitos, maquinas e equipamentos tem sido
disponibilizados para que a comunidade faga suas evolugoes.

Existe também uma filosofia denominada “DIY” (Do it Yourself) literalmente,
“faca vocé mesmo” que tem ganhado cada vez mais seguidores em suas
comunidades. Nelas as pessoas sdo estimuladas a compartilhar projetos de todas
as areas, para que seus membros construam de tudo: artesanato, eletrénicos,
moveis, maquinas, pequenos consertos e muitas outras coisas. Muitas boas ideias
tém sido compartilhadas nessas comunidades, além de contribuir para a

popularizagéo de tecnologias que tem alto custo de investimento.



44

Alguns projetos desse mundo open source/DIY s&o os scanners
tridimensionais por triangulagdo a laser. Abaixo sao apresentadas algumas

iniciativas.
3.8.1 Projeto FabScan

O projeto FabScan surgiu a partir de um trabalho executado por Francis
Engelmann, na Alemanha em 2011. O propdsito do trabalho segundo Engelmann
(2011) foi produzir um scanner 3D de baixo custo, portatil, que fizesse captura do
objeto em 360 graus e que fosse de facil construgao, propagando a cultura DIY (Do-
It-Yourself).

O projeto FabScan® é elaborado com o método de triangulagdo utilizando um
emissor laser motorizado, uma camera e uma base giratoria movida por um motor de
passo controlado por Arduino™, unidos no interior de uma camara de MDF (Medium
Density Fiberboard), recortada com CNC Laser.

A figura 28 apresenta o esquema idealizado por Engelmann (2011) e que,

posteriormente influenciou outros projetos semelhantes.

FIGURA 28 — Scanner FabScan
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Fonte: Adaptado de Fablabo (2015)

3 Projeto FabScan - http://hci.rwth-aachen.de/FabScan
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O projeto passou por uma grande alteracdo em 2014, sendo removido o
motor de passo que controlava o feixe laser, substituida a camera por uma de
melhor resolugédo e o case MDF ganhou novo design com o intuito de facilitar o

manuseio do objeto a ser capturado em seu interior.
3.8.2 Projeto CebScan

Baseado no projeto FabScan, o projeto CebScan utiliza seus componentes
principais com uma abordagem diferente. O CebScan* incorpora dois médulos de
laser que convergem na direcdo do centro do prato giratorio. Ele € uma unidade
aberta, sem revestimento, permitindo maior liberdade de manobra para a
implementagéo dos temas a serem verificados e definigdo do raio laser. Além disso,
este modelo permite a movimentagao vertical do bloco de laser através de um
segundo motor de passo.

O projeto foi disponibilizado na internet com todos os esquemas de
construcado de hardware e software. O corpo do scanner é disponibilizado em
arquivos em formato 3D para construgdo por meio de manufatura aditiva (Impresséo
3D) e o controle dos motores, acionamento dos lasers utilizam a plataforma aberta
Arduino™ acrescido de uma placa adicional com drivers de passo. A figura 29

apresenta o esquema proposto no projeto.

4 Projeto Cebscan — Disponivel em: https://github.com/cebbaker/cebscan/tree/Current
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FIGURA 29 — Scanner CebScan
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Fonte: Adaptado de Fablabo (2015)

O software de controle basico sobre do Cebscan foi modificado para
gerenciar a movimentacdo vertical do bloco cédmeral/laser e o duplo feixe laser;
também gerencia a desativacdo do modo “autofocus” da cémera, que €& um

problema para a digitalizacéo.

3.8.3 Projeto Atlas 3D

O projeto do scanner Atlas 3D° passou por uma campanha de angariagdo de
fundos com a comunidade entusiasta para seu desenvolvimento no final de 2014. O
grande diferencial desse projeto € ser implementado sobre uma plataforma
Raspberry PI™ (minicomputador com memoria e processador proprio) o que
dispensa a necessidade de um computador convencional para controle do scanner e
captura de um modelo. O software de controle e processamento € executado
diretamente no scanner, que tem uma interface acessivel através de um navegador

de internet.

° Atlas 3D — Disponivel em http://www.freelss.org
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FIGURA 30 — Scanner Atlas 3D

<
Fonte: Adaptado de Murobo (2015)

Os mantenedores do projeto Atlas 3D disponibilizam um kit de montagem
para venda, contendo todos os componentes eletrbnicos necessarios e as pegas
impressas por U$260.00 (duzentos e sessenta dolares), incluindo a licenga do
software controlador, acrescido as despesas de frete. No entanto, os esquemas de
montagem e arquivos para impressao do chassi estdo disponiveis para download.

Outro projeto que surgiu baseado no sucesso do Atlas 3D, foi o Raptor 3D
Scanner, com as mesmas caracteristicas, mas misturando partes do chassi

impressas e parte em MDF recortadas a laser.

3.8.4 Projeto Ciclop

Segundo Bq (2015) o scanner 3D Ciclop® é um projeto totalmente livre. O
Ciclop e o Horus (software de captura) tém licenga CC-BY-SA (Creative Commons),
que permite compartilhamento e reelaboracdo, mesmo para uso comercial, desde
que seja dada a atribuicdo e GPL (General Public License), ou seja, requer que 0s
trabalhos derivados sejam licenciados sob a mesma licenga.

Toda a informagao sobre o desenho mecanico, a eletrbnica e o software
estdo disponiveis para a comunidade e passam a pertencer ao Patrimdnio
Tecnologico da Humanidade. A figura 31 apresenta em detalhes as partes do

scanner Ciclop.

® BQ Ciclop — Disponivel em: https://www.bg.com/pt/ciclop
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FIGURA 31 — Scanner BQ Ciclop
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Fonte: Adaptado de Fablabo (2015)

O Ciclop possui dois emissores lasers e base giratoria, como seus
ancestrais. O software de controle dos componentes € baseado em Arduino™, mas a
BQ criou placas especificas para esse produto. A principal, denominada BQ ZUM
CORE e uma extensao acoplada a ela, chamada BQ ZUM SCAN.

A placa ZUM CORE é derivada do Arduino™ UNO (mesmo controlador:
Atmel Mega328P) mas contem elementos como conexdo Bluetooth que ndo s&o
nativos no UNO, a um custo de 36.90 €. A placa complementar, denominada ZUM
SCAN é um extensor CNC com o esquema eletrbnico disponivel, mas vendido
somente no kit eletrénico da BQ. O kit eletrénico € composto pelo ZUM CORE, ZUM
SCAN, camera, lasers e motor a um custo de 159.90 €. Tanto o kit quanto a placa

ZUM CORE sé&o comercializados de forma exclusiva na Europa.
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FIGURA 32 — Placas ZUM Core (esquerda) e ZUM SCAN (direita)
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Fonte: Adaptado de Diwo (2015)

O Scanner BQ Ciclop completo pode ser adquirido exclusivamente nas lojas
da BQ ou em seus parceiros em Portugal e Espanha, a um custo de 249.00 €.

O software Horus desenvolvido por Jesus Arroyo Torrens, atualmente,
engenheiro de software da Bq Labs é disponibilizado sob a licenga GPL, tem seu
cbdigo fonte disponivel para download e esta disponivel para sistemas operacionais
Windows™, Linux™ e MacOS™. Ele &€ o responsavel por executar os calculos
geométricos e geragdo do modelo tridimensional. O diferencial do Horus €& contar

com uma rotina de auto calibragem do scanner.

3.8.5 Comparativo entre Scanners Open Source

Apesar de apresentarem algumas diferengas no processo de construgéao e
configuragdo, os modelos de scanners open source tem seu funcionamento muito
simular, tanto no processo de captura quanto no processo de renderizagdo do
modelo. Os componentes necessarios para construgdo sdo semelhantes, inclusive
nos custos, no entanto, alguns s&o mais dificeis de se adquirir no mercado brasileiro,
sendo necessaria uma importacdo, como € o caso das placas da BQ.

Quanto ao tempo de escaneamento, o maior tempo encontrado foi de quinze
minutos, e o menor foi 2 minutos, dependendo da qualidade desejada no modelo a
ser adquirido. A tabela 1 apresenta um comparativo entre as caracteristicas dos
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scanners open source conforme informag¢des divulgadas pelos mantenedores dos

projetos.
TABELA 1 — Comparativo entre Scanners Open Source

FABSCAN CEBSCAN ATLAS CICLOP
Dimensdes 400x300x290 451x342xVar  365x274x168 455x340x198
Plataforma Giratéria 140 200 177 200
Altura do Laser 151 Variavel 143 175
Angulo (Objeto/Camera/Laser) 33,7° 40,6° 26,8° 30°
Tempo escaneamento 15min 15min 12min 2-8min
Resolugdo da Camera 3MP 3MP 5MP 3MP
Controlador Arduino™ Arduino™ Raspberry™ Zum Core™
Custo Médio no Mercado - - U$ 249.00 U$ 277.00

Fonte: Préprio autor.
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4 MATERIAL E METODOS

Com a realizagdo da revisdo de literatura, foi possivel encontrar projetos
livres de digitalizadores com o método de triangulacdo a laser com diversas
caracteristicas e niveis de maturidade. O conjunto das caracteristicas foram levadas
em consideracdo na escolha, pois, de acordo com o objeto desse trabalho, uma
comparacao de resultados seria necessaria para aplicagdo do scanner em
processos de engenharia reversa.

Dois dos quatro projetos analisados (FabScan e CebScan) ndo s&o vendidos
totalmente montados, os outros dois (Atlas e Ciclop) tem custos parecidos para
importagdo, embora seus paises de origem tenham restrigbes para exportagao
principalmente por conter diodos laser.

Ao analisar as resolugbes das cameras dos projetos, constatou-se que o
Atlas 3D tem uma camera com resolugdo maior, no entanto o software de captura
possui uma licenca de U$ 25,00 a ser adquirida e o nimero de documentagio
disponivel é relativamente baixa.

Assim, o projeto escolhido foi o BQ Ciclop, pois possui uma boa
disponibilidade de documentacédo apesar de ser um produto recente, pois acaba de

completar um ano de langamento.

41 COMPONENTES ELETRONICOS

Como o BQ Ciclop utiliza placas proprias (ZUM CORE e ZUM SCAN) que
nao sao diretamente vendidas para o Brasil pelo sitio da BQ. Por essa razao foi
necessario adaptar o firmware do projeto para funcionamento com placa Arduino™
UNO R3 original, pois é de facil aquisicdo nas lojas de eletrénicos no Brasil. Para
substituicdo do ZUM SCAN, que controla o motor de passo e aciona os moédulos
laser, foi utilizado um SHIELD CNC v3.0 para Arduino ™ com driver de passo A4988,
também de facil aquisicdo. O custo das placas adquiridas foi de R$ 100,00 (Cem
Reais).

Para alimentacdo do SHIELD CNC foi necessaria a aquisicdo de uma fonte
externa de 12V compativel com o Arduino que pode ser encontrada em qualquer loja
de eletrénicos por cerca de R$ 10,00 (Dez Reais)
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A figura 33 apresenta as placas utilizadas nesse projeto substituindo as
placas ZUM.

FIGURA 33 — Arduino Uno, Driver A4988 e Shield CNC V3

Fonte: Préprio autor.

Os dois médulos lasers utilizados nesse projeto foram do modelo 650nm
5mW com tensdo de 3-5V com feixe em linha de cor vermelha e foco ajustavel,
conforme a figura 34. O custo de aquisi¢gdo de cada modulo foi de R$ 20,00 (Vinte
Reais).

FIGURA 34 — Médulo laser com feixe em linha

Ne,

Fonte: Préprio autor.

O motor de passo, responsavel por movimentar a plataforma de
escaneamento utilizado foi o Nema17 fabricado pela Minibea-Matsushita com torque
de 3,7kgf e tensdo de 12V 1A. A figura 35 apresenta o motor Nema17 utilizado no
projeto e adquirido no mercado nacional por R$ 40,00 (Quarenta Reais). Existem

dezenas de fabricantes e capacidades de torque sendo possivel sua substituicao por
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outro semelhante, desde que haja o ajuste do valor de referéncia no driver de passo
A4988.

FIGURA 35 — Motor Nema17

Fonte: Préprio autor.

A cémera utilizada no projeto, responsavel por capturar as imagens do
objeto colocado sobre a base giratéria foi o0 modelo C270 da fabricante Logitech
apresentado na figura 36. E uma webcam de facil aquisicdo no mercado, tem
resolugdo de 3 megapixels e captura videos em alta definicdo (HD). O custo da
C270 adquirida para esse projeto foi de R$ 115,00 (Cento e Quinze Reais).

FIGURA 36 — Camera Logitech C270
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Fonte: Logitech (2016)

4.2 MONTAGEM DOS COMPONENTES ELETRONICOS

O primeiro passo para montagem dos componentes foi a conex&do da placa

Arduino ™ Uno com o Shield CNC. O motor de passo necessita de uma alimentacao
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de 12V que sera enviada através do Shield, no entanto 0 mesmo nao possui
conector tipo plug para uma fonte de energia externa (internamente a tensao € de
5V), precisamos entdo obter essa tensdo diretamente do conector do Arduino™
através de uma soldagem simples de dois fios na parte traseira da placa,
conectando os fios aos pinos de alimentagao do Shield, conforme a figura 37.

FIGURA 37 — Alimentagao Shield CNC

Fonte: Préprio autor.

A conexao dos demais componentes no Shield (acoplado ao Arduino) seguiu
o esquema detalhado na figura 38.



FIGURA 38 — Esquema de Montagem Eletrénica do Scanner
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Fonte: Préprio autor.

em full step, 70% do limite.

Imax = (VRef/ (8 * 0,1)) * 0,7
VRef = (Imax / (8 * 0,1)) * 0,7
VRef = (1*0.8) * 0,7
VRef = 0.56
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O driver A4988 foi inserido no slot X e ajustado para 1A (um ampere). Para
ajuste da tens&o do driver A4988, foi utilizado um amperimetro para medir a tenséo
no pino “ref’ e calculado a corrente resultante sobre os resistores. A tensdo medida
€ relacionada com a corrente através da equacgao 10 apresentada abaixo, conforme
manual do driver A4988:

Limite de corrente é dado pelo VREF (Valor de referéncia) dividido pelo
produto de 8 (oito) pelo resistor. Nesse modelo de A4988, estdo presentes o resistor
R100, que equivale a 0.1Q. Ainda segundo informagdes do datasheet (informagdes
técnicas disponibilizadas pelo fabricante), a operacédo de tensdo do motor deve ser
em 70% de sua capacidade para melhores resultados no motor de passo, ou seja,

(10)
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Logo, para ajuste no limite de tensdo do motor para 1A: VRef = 0,56v.
Girando o mini potencidmetro na base do driver foi possivel o ajuste correto, pois o
mesmo vem de fabrica ajustado para 1.25A.

Nos primeiros testes do circuito eletrénico do projeto foi constatado que o
motor de passo operava ainda com uma velocidade muito alta (mesmo com o ajuste
de corrente) e por essa razdo perdia-se alguns passos e havia um movimento
brusco da bandeja giratoria. Para solucionar esse problema, o CNC Shield foi
ajustado para que o motor trabalhasse em modo Microstepping. ou seja, o tamanho
do passo e velocidade foram reduzidos, mudando seu modo de operagao de Full
Step (padrao) para Sixteenth Step (depois de passar pelo teste do Half Step, Quarter
Step, Eighth Step sem melhoras visiveis); isso foi feito acrescentando-se jumper’s

nos pinos “MS1”, “MS2” e “MS3” localizados embaixo do conector do driver A4988.
4.3 SOFTWARE DE CONTROLE DO HARDWARE

O software responsavel por controle do hardware, que vai acionar os feixes
laser e a plataforma giratoria, conhecido como firmware €& desenvolvido em
linguagem C, no ambiente de desenvolvimento do Arduino, que € de uso livre e esta
disponivel para sistemas operacionais Windows, MacOS e LinuxOS.

Embora o firmware disponibilizado pelo projeto Ciclop, denominado Horus
FW’, segundo o fabricante seja compativel com controlador Arduino, o mesmo esta
programado para interagir com a placa ZUM SCAN, ou seja, pode-se substituir o
ZUM CORE que é derivado do Arduino, no entanto o ZUM SCAN é necessario.

Por essa razdo, algumas alteragdes no projeto do firmware Horus foram
necessarias e propostas por Swindon Maker® em margo de 2015 no repositorio
Github. A alteragao proposta por Swindon no entanto se mostrou ineficiente para a
atual versdo do software Horus Scanner Manager 0.1.2.4, por essa raz&o, foram
feitas as alteracdes no arquivo “CPU_MAP.h” conforme destaques no quadro 1.

" Horus FW - https://github.com/bqlabs/horus-fw
® Horus 3D Scanner Firmware CNC Shield - https://github.com/swindonmakers/horus-fw
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QUADRO 1 — Trecho de cédigo fonte alterado no arquivo CPU_MAP.h

#ifdef CPU _MAP ATMEGA328P_CNCV3 // Arduino Uno for CNC Shield V3

// Serial port pins
#define SERIAL RX USART RX vect
#define SERIAL_UDRE USART UDRE_vect

// Define laser pulse output pins. NOTE: All laser pins must be on the same port.
#define LASER DDR DDRD

#define LASER PORT PORTD

#define LASER1 BIT 4 // Uno Digital Pin 4 Driver Z-STEP

#define LASER2 BIT 7 // Uno Digital Pin 7 Driver Z-DIR

#define LASER3 BIT 4 // Uno Digital Pin 4

#define LASER4 BIT 7 // Uno Digital Pin 7

#define LASER MASK ((1<<LASER1 BIT) | (1<<LASER2 BIT)) // All step bits

// Define step pulse output pins. NOTE: All step bit pins must be on the same
port.

#define STEP DDR DDRD

#define STEP PORT PORTD

#define X STEP BIT 2 // Uno Digital Pin 2

#define STEP MASK (1<<X STEP BIT) // All step bits

// Define step direction output pins. NOTE: All direction pins must be on the
same port.

#define DIRECTION DDR DDRD

#define DIRECTION PORT PORTD

#define X DIRECTION BIT 5 // Uno Digital Pin 5

#define DIRECTION MASK (1<<X DIRECTION BIT) // All direction bits

// Define stepper driver enable/disable output pin (all axis)
#define STEPPERS DISABLE DDR DDRB

#define STEPPERS DISABLE PORT PORTB

#define STEPPERS DISABLE BIT 0 // Uno Digital Pin 8

#define STEPPERS DISABLE MASK (1<<STEPPERS DISABLE BIT)

// Define probe switch input pin.
#define PROBE DDR DDRC

#define PROBE PIN PINC

#define PROBE_PORT PORTC

#define PROBE BIT 5 // Uno Analog Pin 5
#define PROBE MASK (1<<PROBE BIT)

fendif

Fonte: Préprio autor.

Ap0s carregar o firmware alterado para a memoria do Arduino™, os testes de
acionamento do motor e laser puderam ser executados através do software Horus
Scanner Manager. A figura 39 apresenta os testes iniciais de funcionamento dos
componentes eletrénicos do projeto.
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FIGURA 39 — Teste de Componentes Eletrénicos

Fonte: Préprio autor.

4.4 ESTRUTURA DO SCANNER 3D

A BQ Labs, mantenedora do projeto Ciclop disponibilizou os arquivos com os
modelos propostos para impressao 3D. Os arquivo sado disponibilizados em uma
comunidade de entusiastas de impressdo 3D denominada Thingiverse®.

Com a disponibilizagdo dos modelos originais para livre alteragao pela
comunidade, foram surgindo diversas variantes do projeto 3D do Ciclop com o intuito
de se utilizar menos filamento PLA para impressdo ou mesmo sua substituicao total
ou parcial por esquadrias de aluminio, madeira, substituicdo de algumas pecgas por
outros modelos para acoplamento de modelos de cameras diferentes, luzes de led
para iluminar o objeto e muitas outras ideias sdo discutidas pelos usuarios da
Thingiverse.

A figura 40 apresenta a impressao do modelo original proposto pela BQ em
impressora 3D, (FDM - Fusao e Deposi¢cdo de Material) utilizando filamento PLA
(Poli Acido Lactico), para utilizagdo neste projeto.

’BQ Ciclop 3D Parts - http://www.thingiverse.com/thing:740357
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FIGURA 40 — Impressao 3D da Estrutura do Scanner

et B

Fonte: Préprio autor.

As demais partes da estrutura do projeto sao ferragens como barras
roscadas M3 cortadas em 2 partes de 400mm e 1 de 292mm, 28 porcas M8, 18
arruelas M8, 3 parafusos M8x30mm, 7 parafusos M3x10mm e 3 porcas M3.
Também foi necessaria a utilizacdgo de um rolamento modelo 16040
(200x310x34mm).

A plataforma giratéria consiste em um disco de 200mm que pode ser
impresso em 3D como as demais, no entanto, nesse projeto foi feita em MDF de
6mm cortado a laser.

A montagem da estrutura seguiu as orientacdes' do projeto BQ Ciclop
conforme a figura 41. Entre a lente da cAmera e o centro da plataforma giratéria, é

necessaria uma distancia de, pelo menos 30cm.

FIGURA 41 — Sugestao de Montagem da Estrutura do Scanner

Fonte: Adaptado de BQLABS (2015)

0. https://static-bqreaders.s3.amazonaws.com/file/ciclop/01_Ciclop_QSG_Structure EN.pdf
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4.5 AQUISICAO DE MODELOS

Para aquisicdo de modelos, foi utilizado o software Horus 3D Scanner
Manager, na versao 0.1.2.4. A instalacdo € compativel com ambientes Windows,
Linux e MacOS e possui uma rotina de auto calibragem do scanner.

O processo de calibragem envolve um padrdo de xadrez disponibilizado
junto aos arquivos 3D do projeto Ciclop. A Camera detecta o padrao de linhas e
colunas e o software aciona os lasers esquerdo e direito alternadamente enquanto
gira a plataforma nos sentidos horario e anti-horario.

Apods o processo de autocalibragem o scanner esta pronto para ser utilizado
acionando-se a fungdo SCAN. O modelo é exibido em tempo real na tela do Horus.
O software possui trés ambientes de trabalho: Controle, Calibracdo e
Escaneamento.

No ambiente de controle, € possivel configurar detalhes da camera, como
brilho, contraste e saturagédo, pontos importantes para ajuste da luminosidade do
ambiente de operagédo do scanner; controle dos emissores laser, testes do motor e
console de execucado de comandos GCode.

No ambiente de calibragem, € possivel acionar os comandos de ajuste do
sistema, ajustando imagem, padrdo de calibragem, laser, triangulagdo e opgdes
sobre as dimensdes da plataforma giratéria. Cada opgado possui um assistente e
opgdes de insergdo manual dos valores, conforme apresenta a figura 42.
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FIGURA 42 — Fases do processo de Calibragem do Horus
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Fonte: BQLABS (2015)

As condi¢cdes de iluminagdo sdo de suma importancia no processo de
autocalibragem, pois em demasia ou insuficiéncia leva a erros nos valores de
triangulagdo e calculos da matriz de rotacdo e vetor de translagdo imprecisos,
levando o modelo a ndo ter muita precisdo. Varios experimentos calibragem manual
em ambientes diferentes foram realizados no intuito de obtermos melhores
resultados.

Para um melhor resultado, uma calibragem manual foi necessaria no painel
Calibration Workbench. O item Pattern Settings é indicado para configuragao do
padrdao de calibragem do scanner (painel quadriculado contendo 7 linhas e 12
colunas em preto e branco), os valores utilizados nesse item foram Square width: 13,
Pattern row: 6 e Pattern Columns: 11. E necessario informar o valor da distancia da
base do padrao de calibragem e o topo do primeiro quadro preto, conforme orienta o
processo de autocalibragem do Horus.

A configuragdo Camera Intrinsics € um processo que captura 12 fotografias
pressionando a barra de espacgo do teclado quando os quadros se tornarem verdes
em cada foto necesssaria para definicdo de alcance da camera.

A configuragdo Laser Triangulation define o angulo entre o feixe laser e a
camera do scanner, processo essencial para obtencdo do modelo. Os valores

encontrados apos a calibragem podem ser aceitos ou rejeitados; tanto o valor do



62

laser direito quanto o esquerdo devem apresentar valores menores que 0.1 para um
melhor resultado; se isso ndo ocorrer, deve-se experimentar outras fontes de
iluminagao ao refazer a calibragem.

O ultimo ajuste € a altura da plataforma giratoria, que é feito na opgéao
Platform Extrinsics. Esse processo é automatico o scanner definira a altura baseado
no padrao de calibragem.

E importantes salientar que uma mudanca na opgao Camera Intrinsics exige
a recalibragem dos itens Laser Triangulation e Platform Extrinsics.

No ambiente de escaneamento, uma projecdo da plataforma giratoria é
apresentada e, € sobre ela que o modelo tridimensional vai sendo apresentado no
processo de captura.

No ambiente de captura, Scanning Workbench, é possivel exibir o painel de
controle, a visdo da camera em tempo real de captura e o modelo tridimensional
sendo capturado. No painel de controle, é possivel ajustar op¢des de qualidade do
processo para obter textura ou apenas nuvem de pontos, assim como acionar um ou
ambos os lasers. A opgao Point Cloud Generation mostrada na figura 43, exibe um
controle de didametro e altura da area de captura da plataforma, evitando assim que
sejam capturados itens que ndo s&o necessarios, diminuindo indice de ruidos

(pontos alheios) alheios ao objeto pretendido.

FIGURA 43 — Ambiente de Captura do Software Horus
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[ ] [ ] Horus 0.1.2.3

Y%ZbrbuE il
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Fonte: Préprio autor.



63

Apos o término da captura, que pode levar de 2 a 15 minutos, dependendo
da precisdo escolhida, o modelo em formato PLY (Polygon File Format) é gerado
através da opcao File e Save Model. Esse formato € facilmente importado em
softwares de manipulagdo de objetos tridimensionais.

Para uma melhor qualidade da imagem capturada pela cadmera, a distancia
focal foi ajustada abrindo-se a camera e regulando a objetiva manualmente

conforme a figura 44.

FIGURA 44 — Ajuste manual do foco da camera

:
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Fonte: Préprio autor.

4.6 POS PROCESSAMENTO DA NUVEM DE PONTOS

Apos a captura da nuvem de pontos faz-se necessario um processamento
da malha, nessa etapa, foi utilizado o software livre denominado MeshLab''. O
MeshLab possui filtros de limpeza automatica, incluindo a remogao de vértices nao
referenciados ou duplicados, além de arestas nulas.

Primeiramente é necessario abrir o MeshLab e importar a nuvem de pontos
gerada pelo Horus, através da funcédo File > Import Mesh, (importar malha)
seleciona-se o arquivo e clica-se Open (Abrir). A nuvem de pontos do arquivo é
exibida na area de modelagem do MeshLab; se a nuvem foi gerada a partir da

textura do objeto a nuvem apresenta cores, do contrario apenas uma cor cinza no

" _ http://meshlab.sourceforge.net
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objeto é exibida. A nuvem de pontos importada pode conter imperfeicbes causadas
por ma iluminacdo no processo de captura ou simplesmente ruidos que nao fazem
parte do objeto; uma opcéo de selecéo de vértices (select vertexes) esta disponivel
para selegao e excluséo através da opgao Delete Selected Vertex (eliminar vértices
selecionados). A figura 45, apresenta o ambiente do MeshLab exibindo uma nuvem

de pontos capturada pelo Horus.

FIGURA 45 — Ambiente MeshLab
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Fonte: Préprio autor.

Apoés a limpeza da nuvem de pontos, € possivel utilizar um dos métodos
mais comuns na reconstrugcédo de objetos tridimensionais por malha, que toma como
entrada os pontos para calculo dos vetores normais, através da opcédo Filters >
Normals, Curvatures and Orientation > Compute Normals for point sets, conforme

apresenta a figura 46.
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FIGURA 46 — MeshLab — Calculo de Normais do Modelo
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Fonte: Préprio autor.

Na janela apresentada pelo software, sdo exibidos parametros para o
calculo; apos alguns testes de valores, constatou-se que os numeros 10, 50 ou 100
para o campo Neighour Number (numero de vizinhos) tiveram o melhor resultado.
Apos a aplicacédo do calculo, podemos verificar os normais no item Render > Show
Normal/Curvature. Sao exibidas linhas azuis nos vértices indicando os valores dos
vetores normais do modelo pretendido. Se essas linhas que representam os normais
estiverem viradas no sentido oposto ao exterior do objeto, € necessario recalcular os
normais variando a quantidade de vizinhos dos vértices, de modo a se encontrarem
0 maximo possivel na regido externa da nuvem. A figura 47, apresenta um modelo

exibindo os marcadores de normais.
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FIGURA 47 — MeshLab — Exibicdo de Normais
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Fonte: Préprio autor.

Apos o calculo dos normais, a malha esta pronta para reconstrucdo do
modelo, através da opcgao Filters > Remeshing, Simplification and Reconstruction >
Surface Reconstruction: Poisson.

Na janela de configuragdo da reconstrugdo, s&o apresentadas as opgdes de
profundidade da Octree (Octree Depth), também conhecida como “arvore de oito”,
da divisdo do solucionador (Solver Divide) e os valores situam-se entre 6 e 12,
sendo 12 o mais alto grau de exatiddo e por essa raz&o, pode levar varios minutos,
dependendo do computador em utilizagao.

Apos a reconstrucdo, sao exibidas duas camadas no MeshLab: a nuvem de
pontos e o modelo reconstruido; é possivel a exibigdo/omissdo das camadas através
da opgéo View > Show Layer Dialog, clicando nos icones dos olhos presentes na
linha de cada camada.

Para exportagdo do modelo construido, deve-se acionar a opgédo File >
Export Mesh e optar pelo formato “STL”, que é padrdo nos softwares de fatiamento
de impresséo tridimensional.

O MeshLab ainda permite varias op¢des como unir varias nuvens de pontos,
capturadas de diversos angulos do objeto. Para tal, importa-se todas as nuvens
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necessarias e aciona-se a opgao Edit > Align (Editar > Alinhar); no painel de
alinhamento, pode-se alinhar as malhas fixando a primeira (Glue Mesh Here) e
utilizando a opgao Point Based Gluering (colagem baseada em pontos), que aparece
na janela. A colagem baseada em pontos apresenta duas camadas (fixada e a ativa)
lado a lado para que se escolha pontos em comum (pares); melhores resultados
foram encontrados com a escolha de mais de quatro pares em cada camada em
relacdo a camada fixada. Apds concluir o alinhamento (que pode ser repetido até
obter o resultado desejado) clica-se em Process (processar). A unido definitiva das
camadas de nuvens é realizada a partir do menu Filters > Mesh Layer > Flatten

Visible Layers.
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5 RESULTADOS E DISCUSSOES
Apés o término da construgao do scanner como apresentado na figura 48,
foram iniciados os testes de funcionamento, com varias condi¢cdes de iluminacao e

opgdes de calibragem.

FIGURA 48 — Construgao do Scanner Finalizada

Fonte: Préprio autor.

Muitos sdo os fatores que podem influenciar diretamente o processo de
digitalizagdo, mas a principal preocupag¢ao deve ser as condigdes de iluminagédo do
ambiente.

A baixa luminosidade prejudica o processo de calibragem pois os limites e
texturas do objeto ficam ocultos da camera, assim como uma iluminagéo direta no
objeto prejudica sua captura. Se a aquisicdo estiver sendo feita sem as cores,
apenas textura, os emissores lasers iluminam a area no momento da digitalizagéo,
entdo ndo ha necessidade de iluminagao adicional, mas a possibilidade de ruidos
(pontos sem importancia coletados ao redor do objeto) se torna maior.

Também é importante destacar que o material do objeto a ser capturado
pode interferir no resultado final. Se a superficie € demasiadamente reflexiva os

feixes laser sao refletidos e ofuscam a camera, dessa forma, o processo se torna
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mais dificil de se obter precisdo. Assim, os objetos foscos, livres de reflexao, tem os
melhores resultados.

Ha ainda que se destacar um problema quanto a cor, pois os feixes de laser
sao na cor vermelha e o software detecta essa cor para digitalizagdo. Se a superficie
a ser digitalizada for vermelha, existe uma tendéncia a acontecer erros de captura.
Nesse caso, a melhor opcado é diminuir a saturacdo no momento da captura para
tentar reduzir o problema.

Foram digitalizadas pecgas de diversos tamanhos como apresentadas na
figura 49, para se determinar a capacidade de detalhamento do scanner.

FIGURA 49 — Objetos utilizados nos testes de digitalizagao

Fonte: Préprio autor.

A engrenagem helicoidal (esquerda), engrenagem (centro) e eixo (direita)
foram escolhidas por apresentarem geometrias variadas e complexas, permitindo
definicao do grau de precisdo do modelo digitalizado. Também foi utilizada uma
esfera metalica nos testes por se tratar de uma geometria simples, mas que pode
causar problemas na reflexdo dos feixes laser, conforme pode ser visto na figura 50.
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FIGURA 50 - Digitalizagéo de Esfera Metalica

Fonte: Préprio autor.

Apos digitalizacdo dos objetos e posterior reconstrugdo do modelo no
software MeshLab, uma medicdo foi realizada no modelo do eixo para uma
comparagao com as medidas da peca real, conforme a figura 51.

FIGURA 51 — Comparacao de Medidas do Modelo e da Peca Real

Fonte: Préprio autor.

O eixo real possui um tamanho de 110,99mm e no modelo o tamanho
encontrado foi de 109,49mm. A esfera metdlica apresentada na figura 52, também
foi digitalizada, modelada e medida apresentando resultados semelhantes.
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FIGURA 52 — Comparativo entre esfera metalica real e modelo obtido

Fonte: Préprio autor.

O didmetro real da esfera é de 31,74mm, enquanto o valor encontrado no
modelo foi de 27,32mm.

As engrenagens submetidas ao teste foram capturadas duas ou trés vezes
sendo colocadas em posigdes diferentes na plataforma rotatéria do digitalizador. As
nuvens de pontos encontradas foram unidas no MeshLab e alinhadas por intermédio
de 4 pares cada. No entanto, devido a condi¢gbes de iluminagdo alguns pontos n&o
foram capturados em nenhuma malha, causando problemas no processo de
reconstrugdo. Essas pegas carecem de um tratamento em software de modelagem
adequado para reconstrugao dos espagos (buracos) na superficie do sélido obtido
no MeshLab.

O software MeshLab possui diversos filtros que podem melhorar a qualidade
do modelo obtido a partir da nuvem de pontos, a figura 53 apresenta um modelo do
eixo digitalizado e melhorado com o uso do filtro de suavizagdo Taubin. (Taubin
Smooth) que aplica um algoritmo de suavizagdo nas faces selecionadas de acordo

com os parametros fornecidos pelo usuario.
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FIGURA 53 — Modelo melhorado com filtro de suavizacao
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Fonte: Préprio autor.

Nesse modelo apresentado na figura 53, também foi aplicado o artificio de
transferéncia das cores dos vértices para a malha construida, obtendo-se assim um
modelo colorido, em vez do tradicional cinza.

Quanto ao relevo da superficie, varios testes foram realizados, ajustes de
focos e iluminagado, no entanto a medicao de relevo s6 pode ser realizada na nuvem
de pontos, pois a reconstrucdo do modelo através dos calculos de normais,
preenche os espagos entre os pontos e mascara a distancia encontrada. A figura 54
apresenta a malha obtida no corpo do eixo capturado nos testes do digitalizador.

FIGURA 54 — Medi¢des de superficie na malha de pontos

“=0.679535

Fonte: Préprio autor.
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Apesar de ser uma possivel forma de se encontrar uma rugosidade da
superficie, ndo é muito precisa porque depende diretamente da capacidade do
sensor CCD (Dispositivo de Carga Acoplada) da camera utilizada no processo e do
operador demarcar os pontos para medicdo. No exemplo acima a distancia entre os
niveis dos pontos capturados foi de aproximadamente 0,68mm.

A fim de analisar o impacto da superficie polida (reflexiva) e escuras, foram
realizados testes em objetos comuns apresentados na figura 55 e os resultados sao
de uma preciséo aceitavel, no entanto, alguns pontos sdo equivocados na superficie
de ceramica polida (duas algas) causando problemas na forma. Na parte direita da
figura 55 é apresentada uma lata de refrigerante em cor escura, com partes em
vermelho e partes reflexivas; nesse teste o modelo também sofreu uma deformacgéao
dando a impresséao de “lata amassada”, quando na verdade o que aconteceu foi uma
reflexdo da luz do laser.

FIGURA 55 — Objetos com superficie reflexiva e com partes em vermelho

Fonte: Préprio autor.

Ajustes na iluminacdo e saturacdo da camera tendem a melhorar a

qualidade da nuvem de pontos obtida.
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6 CONCLUSOES

O scanner proposto nesse estudo foi construido com um custo total de R$
590 (quinhentos e noventa reais), mostrando assim que € possivel a popularizagao
tecnologia de digitalizagdo tridimensional no pais. As aplicagdes para o scanner s&o
as mais diversas em varios setores da industria e educacéo.

Também teve-se intuito de analisar a qualidade dos modelos obtidos a fim
de se extrair caracteristicas da superficie do objeto digitalizado; concluiu-se que
alguns dados podem ser visualizados, no entanto, ha uma limitagao técnica quanto a
resolucdo da camera utilizada nesse equipamento e o software necessario. Os
testes realizados mostram aumento de qualidade e apontam o indicio de que mais
detalhes podem ser obtidos com a utilizagdo de uma camera de melhor resolucao,
com lentes especificas de acordo com a distdncia do objeto pretendido. Também, a
construgcao de um software adequado a essa medicédo de superficie, pois as funcdes
existentes nos softwares utilizados nesse estudo sido de dificil utilizacdo para esse
propaosito.

Uma das dificuldades encontradas nesse projeto foi a reunido de todas as
informacdes necessarias tanto para construcdo do scanner quanto para operacao
dos softwares de captura e pds processamento de malha de pontos, pois nem todas
as comunidades de softwares e hardware livres possuem uma boa documentacao,
ficando assim muitas informacgdes retidas com seus membros. Muita pesquisa foi
realizada diretamente com essas pessoas a fim de se obter suas experiéncias na
resolucido de problemas relacionados a componentes e softwares.

O presente estudo busca entio torna-se um compéndio dessas experiéncias
de usuarios e informagdes técnicas de construgao e configuragao e operagéo de um
scanner tridimensional pelo método de triangulagdo a laser, para que o mesmo

possa ser reproduzido sem maiores complicagdes.
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7 SUGESTOES PARA TRABALHOS FUTUROS

seqguir:

Para continuidade desse trabalho, algumas sugestées séo indicadas a

Implantagdo de circuito de iluminagdo com lampadas LED proximas a
camera para amenizar o impacto do excesso ou auséncia de luz no objeto
capturado;

Substituicdo do modelo da camera utilizada no projeto por um modelo
SLR (Digital Single Lens Reflex) e objetiva com curta distancia focal, para
melhor detalhamento da superficie;

Criagédo de software para analise das imagens e detecgdo automatica da
diferenga de nivel entre os pontos da malha obtida, evidenciando assim
uma rugosidade da superficie de forma mais precisa;

Substituicdo do controlador ARDUINO por um mini computador do tipo
RASPBERRY PI, permitindo assim que o scanner seja operado
remotamente ou mesmo apenas conectando um monitor, teclado e mouse
diretamente ao scanner, pois o mesmo ja teria todos os softwares

necessarios e previamente configurados.
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